27 August 2020 (2:00 pm – 4.30 pm)
Organised for Nursing Graduates from ALCNS

Presented by:
Annelissa Chin
NUS Libraries
mdlib@nus.edu.sg
What we will cover today

1. Recap on systematic review
2. Preparing an EndNote Library for systematic review [e-learning]
3. Defining a focused question
4. Identifying sources to search
5. Search syntax
6. Subject heading vs. keyword search
7. Developing search strategy
   a. Pubmed
   b. The Cochrane Library
   c. Embase
   d. CINAHL
8. Reporting the search process
9. Managing search results with EndNote
   ▪ Remove duplicates [e-learning]
   ▪ Export the Endnote Library to Excel
   ▪ Cite While You Write [e-learning]
A systematic review attempts to collate all empirical evidence that fits pre-specified eligibility criteria in order to answer a specific research question. It uses explicit, systematic methods that are selected with a view to minimizing bias, thus providing more reliable findings from which conclusions can be drawn and decisions made (Antman 1992; Oxman 1993).

~ Section 1.2.2 What is a systematic review in the Cochrane Handbook for Systematic Reviews of Interventions ~

https://handbook-5-1.cochrane.org/chapter_1/1_2_2_what_is_a_systematic_review.htm
Before Doing A Systematic Review

Has a review been done before?

Search the systematic review databases:
• Prospero http://www.crd.york.ac.uk/PROSPERO
• Cochrane Reviews https://www.cochranelibrary.com/
• PubMed
• Embase

Write & register your review
• Write your protocol
• Refer to the PRISMA for systematic review protocols (PRISMA-P) for reporting standard for protocols http://www.prisma-statement.org/Extensions/Protocols.aspx
• Register your research (e.g. Prospero or Cochrane)
2. PREPARING AN ENDNOTE LIBRARY FOR SYSTEMATIC REVIEW (E-Learning)
Create A New EndNote Library

1. Search Windows > EndNote
2. Click on File > New
3. Enter a filename e.g. **SysReview** (.enl)
4. Select location to save the library (e.g. on your Desktop)
5. Click **Save**
How to move?

Where?

Back-up

Compressed file

Raw files

My EndNote Library

My EndNote Library Data

.enlx
Customise Fields To Display Record Number

EndNote Preferences

- Change Case
  - Display Fields
  - Display Fonts
  - Duplicates
  - Find Full Text
  - Folder Locations
  - Formatting
  - Libraries
  - PDF Handling
  - Read / Unread Reference Types
  - Sorting
  - Spell Check
  - Sync
  - Temporary Citations
  - Term Lists
  - URLs & Links

Fields to display in the library window

Position | Field | Heading
---|---|---
Column 1 | Record Number | Record Number
Column 2 | File Attachments | File Attachments
Column 3 | Author | Author
Column 4 | Year | Year
Column 5 | Title | Title
Column 6 | Volume | Volume
Column 7 | Journal/Secondary Title | Journal
Column 8 | Last Updated | Last Updated
Column 9 | Reference Type | Reference Type
Column 10 | Name of Database | Name of Database

Note: Selecting the 'Figure' and 'File Attachment' fields will display an icon in the library window.

- Display all authors in the Author field

EndNote Preferences window with 'Display Fields' option selected and 'Record Number' field added to the list.
‘My Groups’ Feature In EndNote

My Library
- All References (50)
- Configure Sync...
- Recently Added (0)
- Unfiled (50)
- Trash (0)
- My Groups
- Mammogram
- Jet Lidocaine
  - Cochrane (0)
  - Embase (0)
  - PubMed (0)
- Find Full Text (0)

Group Set
- Group 1
- Group 2
- Group 3
3. DEFINING A FOCUSED QUESTION

- PICO Model
- Concepts
# PICO Model

A useful tool/framework for asking focused clinical questions

<table>
<thead>
<tr>
<th></th>
<th>P</th>
<th>I</th>
<th>C</th>
<th>O</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Population</strong></td>
<td>Patients</td>
<td>Interventions or exposures</td>
<td>Comparison</td>
<td>Outcomes</td>
</tr>
<tr>
<td><strong>Problems</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>How would you describe a group of patients?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>What is the problem?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>What are they exposed to?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>What do we want to do with them?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>What is the main alternative being considered, if any?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>What are you trying to accomplish, measure, improve, or affect?</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Topic:** What are nurses’ attitudes toward death of caring for dying patients?

<table>
<thead>
<tr>
<th>Concepts</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CONCEPT 1</strong></td>
<td>Nurses</td>
</tr>
<tr>
<td><strong>CONCEPT 2</strong></td>
<td>Attitudes toward death</td>
</tr>
<tr>
<td><strong>CONCEPT 3</strong></td>
<td>Palliative or terminal care</td>
</tr>
<tr>
<td><strong>FILTERS</strong></td>
<td>Apply only where necessary. E.g. Review filter, Systematic review filter, Age filter, Publication date filter</td>
</tr>
</tbody>
</table>

*Health Services Research (HSR) PubMed Queries* (select Qualitative Research)
You are a pediatric emergency medicine physician. During your daily practice, you are frequently faced with distraught children who have to undergo the common needle related procedures.

Now a new needle-free jet injection of lidocaine has been introduced into the market. “Just ask any child or parent who’s experienced the ‘soda pop thing’ before an IV start and you’ll hear them state that the needle “didn’t hurt at all.”

You want to know whether it helps to minimise the pain and distress associated with needle procedures compared to the other anaesthesia or sham treatment.
Formulate PICO Question

Clinical Question: What is the efficacy of jet lidocaine for children undergoing needle-related procedure?

<table>
<thead>
<tr>
<th>PICO Elements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>PATIENT (P)</td>
<td>Children undergoing needle related procedure</td>
</tr>
<tr>
<td>INTERVENTION (I)</td>
<td>Jet administration of lidocaine</td>
</tr>
<tr>
<td>COMPARATOR (C)</td>
<td>Jet placebo or other anaesthesia procedure</td>
</tr>
<tr>
<td>OUTCOME (O)</td>
<td>Pain score, patient satisfaction, patient cooperation, length of cry etc...</td>
</tr>
<tr>
<td>STUDY DESIGN (S)</td>
<td>Randomised Controlled Trials (RCT)</td>
</tr>
</tbody>
</table>
The Evidence Pyramid

- Describes a hierarchy, where systematic reviews are seen as the most reliable form of evidence.
- Help you to consider the quality and reliability of evidence

Source: http://www.nhsevidencetoolkit.net/what-is-evidence/
Exercise 1: Plan your search

Define your clinical question using PICO (E-Learning)
4. IDENTIFYING SOURCES TO SEARCH

Sources Of Information

**Core databases**
- PubMed
- Embase
- Cochrane Library

**Subject specific databases**
- PsycINFO (OVID)
- CINAHL Plus with Full Text (EBSCOhost)
- Physiotherapy Evidence Database (PEDro)
- OTseeker
- ERIC

**Reference list of key articles**
Hand searching
Key journal/conference abstract

**Gray/grey literature**
Trials registry, thesis, report, meeting/conference abstracts, etc.

**Consulting Expert**
Ongoing and unpublished data

**ALL** relevant studies must be found by searching
Search strategy – Refined, documented (i.e. you must keep a record of all searches)

Refer to Systematic review subject guides at [http://libguides.nus.edu.sg/sysreviews](http://libguides.nus.edu.sg/sysreviews)
5. SEARCH SYNTAX

- Boolean logic
- Phrase searching
- Truncation/wildcards
- Parenthesis
**BOOLEAN OPERATOR**

**OR** -- either terms may be present
→ more results
  e.g. cancers **OR** neoplasms

**AND** both terms must be present
→ fewer results
  e.g. jet injection **AND** lidocaine

**NOT**  → Use with caution*
→ e.g. Humans **NOT** animals
  *Studies on **both humans AND animals** (intersection area) would be missed

**Note:** Boolean operators must be entered in UPPERCASE.
More Search Syntax

PHRASE SEARCHING (using “ ”)
“J-Tip lidocaine”

TRUNCATION
Therap* → find therapy, therapies, therapeutic, therapeutics, etc. 
(Note: PubMed requires 4 or more characters for a wildcard search.)

WILDCARDS (example in MedLine (OVID))
an?esthesia → find anesthesia or anaesthesia
Organisation → find organization or organisation

BRACKETS/PARENTHESIS
jet AND ( lignocaine OR lidocaine )
6. SUBJECT HEADINGS VS KEYWORD SEARCHING
What Is PubMed/MEDLINE?

- PubMed comprises more than 30 million citations for biomedical literature from MEDLINE, life science journals, and online books.
- MEDLINE, largest component of PubMed (26 million records from 5600 journals)
- Search interface developed by the National Center for Biotechnology Information (NCBI) at National Library of Medicine (NLM)

**MEDLINE**

- Biomedical literature database covering the fields of medicine, dentistry, nursing and health care system
- Medline records are indexed using MeSH
- Updated daily – in press, ahead of print
- Coverage: US & 80 other countries

WHAT IS SUBJECT HEADING

Controlled vocabulary, thesauri or indexed terms
- Medline – MeSH (Medical Subject Headings)
- Embase – Emtree
- CINAHL – CINAHL Headings
- PsycINFO – Thesaurus of Psychological Index Terms

Why subject heading?
- Consistent way to retrieve information that may use different terminology for the same concept

```
“NEOPLASMS”[MeSH]
```

- CANCER
- TUMOR
- MALIGNANCY
- NEOPLASIA
- NEOPLASIAS
- LYMPHOMA
- LYMPHOMAS

- CANCERS
- TUMORS
- MALIGNANCIES
MeSH (Medical Subject Headings)

If you need to expand your search, consider the Entry Terms (synonyms) in keyword search.

Broader subject heading: Injections, Jet
Narrower subject heading: Injections, Subcutaneous

Other ways to find Synonyms:
- Thesaurus
- Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue and Subject terms in Library catalogue
- Key concepts or Descriptors (Author supplied)
- Find a review article and look for the “keywords” used to search the different databases

Entry Terms:
- Jet Injections
- Injection, Jet
- Jet Injection
Adding MeSH Term To PubMed Search Builder

1. Enter "jet injection" in the MeSH search field.
2. Select "Injections, Jet" from the search results.
3. Click on "Injections, Jet"[Mesh].
5. Click "Search PubMed".
Keywords

- ‘Free text’ or ‘text word’
- Imprecise
- Useful when you cannot find suitable MeSH term
- Give the latest studies

List of possible keywords related to “jet injection of lidocaine”

<table>
<thead>
<tr>
<th>Keywords on ‘jet injection’</th>
<th>Keywords on ‘lidocaine’</th>
</tr>
</thead>
<tbody>
<tr>
<td>jet</td>
<td>lidocaine</td>
</tr>
<tr>
<td>J-tip</td>
<td>lignocaine</td>
</tr>
<tr>
<td>needle-free</td>
<td>xylocaine</td>
</tr>
<tr>
<td>“needle free”</td>
<td>xylocaine</td>
</tr>
<tr>
<td>“no needle”</td>
<td>xylocitin</td>
</tr>
<tr>
<td>needleless</td>
<td>dalcaine</td>
</tr>
<tr>
<td>needle-less</td>
<td>octocaine</td>
</tr>
</tbody>
</table>
Example of Keywords from Scopus Database

Journal of Neurosurgical Anesthesiology
Volume 16, Issue 2, April 2004, Pages 156-159

Jet injection of local anesthetic decreases pain of arterial cannulation in awake neurosurgical patients (Review)

Author keywords
- Arterial cannulation
- Jet injection
- Local anesthetic
- Needlestick injuries

Indexed keywords
- bicarbonate
- lidocaine
- local anesthetic agent
- local anesthetic agent

EMTREE drug terms:
- adult
- aged
- artery catheterization
- cannulation
- clinical article
- clinical trial
- controlled clinical trial
- controlled study
- female
- human
- jet injection
- local anesthesia
- male
- needle
- needlestick injury
- neurosurgery
- observer variation
- pain assessment
- priority journal
- randomized controlled trial
- review
- scoring system
- skin
- syringe
- urticaria
- visual analog scale
- wakefulness
- article
- catheterization
- jet injection
- middle aged
- pain
- pathology

EMTREE medical terms:

MeSH:
- Aged
- Anesthetics, Local
- Catheterization, Peripheral
- Female
- Humans
- Injections, Jet
- Male
- Middle Aged
- Neurosurgical Procedures
- Pain
- Pain Measurement
- Skin
- Wakefulness

View all 9 citing documents
Inform me when this document is cited in Scopus:
- Set citation alert
- Set citation feed

Related documents
- Painless intravenous catheterization by intradermal jet injection of lidocaine: A randomized trial
MeSH Versus Keywords

- Least precise
- Broadest
- Current (retrieve latest studies pending MeSH indexing)

- More precise
- Narrower
- Slightly dated (miss latest studies due to delay in indexing)

- Most precise
- Not recommended to use to build search for systematic review
Exercise 2: Plan your search

1. Identify relevant **MeSH terms** via MeSH database
2. Identify synonyms to build **keyword** search statement
7. DEVELOPING SEARCH STRATEGY

a. MEDLINE (via PubMed)
‘Intervention’ Terms - Construct the Search Strategy

1. To search MeSH terms for ‘l’ term (Jet injection of lidocaine)
2. To search the keywords for ‘l’ term
   a) Brainstorm for synonyms or related terms
   b) Combine similar concepts with ‘OR’ operators
   c) Search specifically in title/abstract ([tiab]) field

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>jet</td>
<td>&quot;Injections, Jet&quot;[Mesh]</td>
<td>jet</td>
</tr>
<tr>
<td>administration of lidocaine</td>
<td></td>
<td>J-tip</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle free&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;no needle&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needleless&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>&quot;needle-less&quot;</td>
</tr>
</tbody>
</table>
### ‘Intervention’ Terms - Construct the Search Strategy

<table>
<thead>
<tr>
<th>Concepts</th>
<th>MeSH</th>
<th>Keywords</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jet administration of lidocaine</td>
<td>&quot;Injections, Jet&quot;[Mesh]</td>
<td>jet OR J-tip OR “needle-free” OR needle free OR no needle OR needleless OR needle-less”</td>
</tr>
<tr>
<td></td>
<td>&quot;Lidocaine&quot;[MeSH]</td>
<td>lignocaine OR lidocaine OR xylocaine</td>
</tr>
</tbody>
</table>

**Note:** For keyword search statement, append [Title/abstract] or [tiab] field tag next to each keyword, e.g.

Steps to append **Title/Abstract** field to the keyword search statement on jet injection concept

1. **Add terms to the query box**
   - Title/Abstract
   - Jet OR J-tip OR needle-free OR needle free OR no needle OR needleless OR needle-less

2. **Query box**

3. **Search**
   - Add to History

4. **History and Search Details**
   - Search: "Injections, Jet"[Mesh]
   - Results: 1,890
Steps to build the search statement for Lidocaine concept

1. Repeat MeSH search for "Lidocaine"[MeSH] in MeSH database (see #4 in screen shot below)
2. Back to Advanced page, key in the below into Add term to the Query box
   lignocaine OR lidocaine OR xylocaine
3. Select Title/Abstract from the All fields dropdown
4. Click ‘ADD’ followed by ‘ADD’ to History (see #6 in screen shot below).
Search Strategy For ‘Intervention’
- Jet administration Of Lidocaine

5. Combine #3 & #6 using ‘AND’ operator (see #7)

Date of Search 20/8/2020

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>#6</td>
<td>Search: (“Lidocaine”[Mesh]) OR (lignocaine[Title/Abstract] OR lidocaine[Title/Abstract] OR xylocaine[Title/Abstract])</td>
<td>33,696</td>
</tr>
<tr>
<td>#1</td>
<td>Search: &quot;Injections, Jet”[Mesh] Sort by: Most Recent</td>
<td>1,909</td>
</tr>
</tbody>
</table>
### Search Strategy For ‘Population’
- Children who are fearful of needle-related pain

<table>
<thead>
<tr>
<th>Patient = Child/children/infant/paediatric with fear of pain (Combining MeSH and keyword)</th>
<th>Items Found</th>
</tr>
</thead>
</table>

Date of Search: 20/8/2020
### Cochrane Randomized Controlled Trial Filters

<table>
<thead>
<tr>
<th>PUBMED</th>
<th>EMBASE</th>
<th>MEDLINE (OVID)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(randomized controlled trial[pt] OR controlled clinical trial[pt] OR randomized[tiab] OR placebo[tiab] OR drug therapy[sh] OR randomly[tiab] OR trial[tiab] OR groups[tiab] NOT (animals [mh] NOT humans [mh]))</td>
<td>'crossover procedure':de OR 'double-blind procedure':de OR 'randomized controlled trial':de OR 'single-blind procedure':de OR (random* OR factorial* OR crossover* OR cross NEXT/1 over* OR placebo* OR doubl* NEAR/1 blind* OR singl* NEAR/1 blind* OR assign* OR allocat* OR volunteer*):de,ab,ti</td>
<td>(randomized controlled trial or controlled clinical trial).pt. or randomized.ab. or randomised.ab. or placebo.ab. or drug therapy.fs. or randomly.ab. or trial.ab. or groups.ab.) not (exp animals/ not humans.sh.)</td>
</tr>
<tr>
<td><a href="http://work.cochrane.org/pubmed">http://work.cochrane.org/pubmed</a></td>
<td><a href="http://work.cochrane.org/embase">http://work.cochrane.org/embase</a></td>
<td>Box 6.4.c: Cochrane Highly Sensitive Search Strategy for identifying randomized trials in MEDLINE: sensitivity-maximizing version (2008 revision); Ovid format <a href="http://handbook-5-1.cochrane.org/">http://handbook-5-1.cochrane.org/</a></td>
</tr>
</tbody>
</table>
Applying Cochrane RCT Filters In PubMed

1. Copy the RCT filter and run a search in PubMed (see #8 in the screen shot below).
2. Combine with #7 and #8 using AND (see #9 in the screen shot below).
Navigate Search Results In PubMed

- Filters
- Save
- Sort by most relevant
- Summary view change to Abstract view

[Image of PubMed search results page with highlighted features]

- MY NCBI FILTERS
- All (73)
  - National University of Singapore Libraries (0)
- RESULTS BY YEAR
- TEXT AVAILABILITY
- 1967
- 2020
Export Citations From PubMed To EndNote

• PubMed limits the export of references to <10,000.
The EndNote Library

• We recommend you to create one EndNote Library per project.
EndNote: Organise Citations Using ‘Groups’

In Endnote, select the citations, then right-click.
PubMed: Register for PubMed Account

- Click ‘Log in’ on the top right corner of the PubMed Homepage

- Register for an NCBI account or login in via partner organization account (e.g. Google login)
PubMed: Save Searches/Create Alerts

Click on "Create Alert" to save your search

Select "Frequency" to receive alerts
7. DEVELOPING SEARCH STRATEGY

b. The Cochrane Library (Wiley)
https://www-cochranelibrary-com.libproxy1.nus.edu.sg/
Access the Cochrane Library via Library portal at
https://www-cochranelibrary-com.libproxy1.nus.edu.sg/
Cochrane Search Interface

SEARCH FUNCTION

<table>
<thead>
<tr>
<th>FEATURE</th>
<th>Who should use it, What does it do and What’s New</th>
</tr>
</thead>
</table>
| **SEARCH**       | • For users interested in performing quick searches with a few terms  
                  • For experienced users who prefer to use pull down menus to search fields  
                  • Includes auto-suggest feature **NEW**  
                  • Supports up to five search rows |
| **SEARCH MANAGER** | • For searchers interested in creating complex strategies.  
                     • Supports Boolean and proximity operators, nesting, and field searching  
                     • Combine search line  
                     • Insert a line, add one search to another and orphan line detection **New** |
| **MEDICAL TERMS** | • For users wanting comprehensive searching of medical concepts using MeSH  
                     • Includes auto-suggest feature **NEW**  
                     • All MeSH information, permuted index, tree(s) and results, on one page  
                     • Improved qualifier search and support for all thesaurus functions |
| **BROWSE**       | • Browse Cochrane Reviews by:  
                     • Topic, new reviews, updated reviews, A – Z or Review group  
                     • Browse all other Cochrane Library Databases  
                     • Other Reviews, Trials, Methods Studies, HTA, Economic Evaluations |
Searching MeSH Terms For ‘Intervention’

Follow step 1-6 to do a MeSH search for intervention ‘jet injection’
1. Enter the keywords directly into the search box #2 as shown
2. You can add the suffix : ti,ab to the end of the term
3. Enclose search terms with () before appending : ti,ab if you are entering more than one word in a field search
4. Repeat **MeSH search and Keyword** search for ‘**lidocaine**’
5. Combining concepts on ‘jet injection’ (#3) and ‘lidocaine’ (#6) with ‘**AND**’ (see search results for ‘I’ in #7)
### Cochrane Search Results

Scan the results and retrieve the relevant full text articles

<table>
<thead>
<tr>
<th>Cochrane Reviews</th>
<th>Cochrane Protocols</th>
<th>Trials</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>81</td>
</tr>
</tbody>
</table>

For COVID-19 related studies, please also see the Cochrane COVID-19 Study Register

#### 1. Evaluation of a needle-free jet-injection system

- **Cochrane Central Register of Controlled Trials**
- Issue 8 of 12, August 2020
- **Needle-free jet injection of lidocaine for local anesthesia during lumbar puncture: a randomized controlled trial**
  - A. Ferayomi, R. Yglesia, M. Bryson, D. Bulloch
  - Pediatric emergency care, 2012, 28(7), 687-690 | added to CENTRAL: 31 December 2013 | 2013 Issue 12

#### 2. Comparison of Chiba Needle and J-Tip Needleless Systems

- **Cochrane Central Register of Controlled Trials**
  - Issue 8 of 12, August 2020
- **A needle-free jet-injection system with lidocaine for peripheral intravenous cannula insertion: a randomized controlled trial with cost-effectiveness analysis**
  - C. Lysakowski, L. Dumont, M. Trambi, E. Tassonyi

#### 3. Injection of 1% buffered lidocaine versus topical ELA-Max for anesthesia before peripheral intravenous catheterization in children: a randomized controlled trial

- **Cochrane Central Register of Controlled Trials**
  - Issue 8 of 12, August 2020
- **Jet Injection of 1% buffered lidocaine versus topical ELA-Max for anesthesia before peripheral intravenous catheterization in children: a randomized controlled trial**
  - S. Spanos, R. Booth, H. Koenig, K. Sikes, E. Gracely, J. K. Kim
  - Pediatric emergency care, 2006, 24(8), 511-515 | added to CENTRAL: 31 January 2009 | 2009 Issue 1
Save & Manage Search Strategy

Login to your account & save your searches

1. Click Save this search

2. Login required
Open your Endote Library
Double click the downloaded file (‘citation-export.RIS’) to import the citations into EndNote.
7. DEVELOPING SEARCH STRATEGY

c. Embase (Elsevier.com)

https://www-embase-com.libproxy1.nus.edu.sg/
Subject coverage
• Biomedical (in-depth coverage of pharmacology, pharmaceutical science and clinical research)
• Medical devices
• Life sciences & Allied Health

Content :
• >30% of Embase journal titles are unique (i.e., not covered by MEDLINE)
• >32 million published and peer-reviewed records, in-press publications
• Over 2.4 million conference abstracts indexed from more than 7,000 conferences from 2009
• Coverage of 8,500 indexed peer-reviewed journals from 1947

Strength:
• Deep full-text indexing with Emtree thesaurus (75,000+ terms), includes all MeSH terms, particularly strong in drug, disease and medical device terms
EMTREE - Search ‘Jet Injection’

1. Search Intervention term
   Step 1. Search for the subject heading on ‘jet injection’
   Click on EMTREE (Embase subject headings)
   Enter word or phrase without quote ‘jet injection’ into the search box
   Click on ‘Add to Query Builder’
   Click ‘Search’
Step 2. Build the keyword search statement on ‘jet injection’
At the search box, paste the following search statement
(Jet OR J-tip OR “needle-free” OR “needle free” OR “no needle” OR needleless OR “needle-less”):ti,ab

930 results for search #1

Reducing bend scour using in-phase and out-of-phase hydraulic jets
Tamoradi Z., Ahadiyan J., Najarchi M., Hasounizadeh H., Najafizadeh M.M.
Step 3. Combine subject heading and keyword search statement on ‘jet injection’, using ‘OR’ operator, i.e.

#1 OR #2
Step 4. Repeat the same steps to search for the subject heading on ‘lidocaine’

Click on EMTREE

Enter word or phrase without quote ‘lidocaine’ into the search box

Click on ‘Add to Query Builder’
Keyword Search Strategy - ‘Lidocaine’

Step 5. Build the keyword search statement on ‘lidocaine’

At the search box, paste the following search statement:

(lignocaine OR lidocaine OR xylocaine):ti,ab
Step 6. Combine subject heading and keyword search statement on ‘lidocaine’ using ‘OR’ operator, i.e.

#4 OR #5
Step 7. Combine search results on 'jet injection' AND 'lidocaine' using 'AND' operator, i.e.

#3 AND #6
Export Embase Citations to EndNote

1. Results
2. Select number of items: 248
3. Export
4. Export as ‘RIS format’

Open Endote software & double click the ‘records.ris’ file to import the citations to EndNote.
7. DEVELOPING SEARCH STRATEGY

d. CINAHL (via EBSCOhost)
CINAHL Search Interface
Searching Subject Heading For ‘I’ Term

1. Suggest Subject Terms
2. Search
3. Select Subheadings
4. Search Database
Searching Keyword For ‘I’ Term

Search Terms

<table>
<thead>
<tr>
<th>Search ID#</th>
<th>Search Terms</th>
</tr>
</thead>
</table>
| S4        | TI: lignocaine OR lidocaine OR xylocaine OR jet OR "j tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR "needleless" OR "needle-less"
| S3        | MH: "Lidocaine"
| S2        | TI: lignocaine OR lidocaine OR xylocaine OR jet OR "j tip" OR "needle-free" OR "needle free" OR "no needle" OR "needleless" OR "needle-less" OR "needleless" OR "needle-less"
| S1        | MH: "Injections, Jet" |
## CINAHL Search Strategy

<table>
<thead>
<tr>
<th>Search Term Details</th>
<th>Search Options</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>S7 S3 AND S6</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (54)</td>
</tr>
<tr>
<td>S6 (TI lignocaine OR lidocaine OR xylocaine OR AB lignocaine OR lidocaine OR xylocaine) AND (S4 OR S5)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (6,935)</td>
</tr>
<tr>
<td>S5 TI (lignocaine OR lidocaine OR xylocaine) OR AB (lignocaine OR lidocaine OR xylocaine)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (4,845)</td>
</tr>
<tr>
<td>S4 (MH &quot;Lignocaine&quot;)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (5,234)</td>
</tr>
<tr>
<td>S3 (TI Jet OR J-tip OR needle-free OR needle free OR no needle OR needleless OR needle-less OR AB Jet OR J-tip OR needle-free OR needle free OR no needle OR needleless OR needle-less) AND (S1 OR S2)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (3,189)</td>
</tr>
<tr>
<td>S2 TI (Jet OR J-tip OR needle-free OR needle free OR no needle OR needleless OR needle-less) OR AB (Jet OR J-tip OR needle-free OR needle free OR no needle OR needleless OR needle-less)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (3,188)</td>
</tr>
<tr>
<td>S1 (MH &quot;Injections, Jet&quot;)</td>
<td>Expanders - Apply equivalent subjects</td>
<td>View Results (146)</td>
</tr>
</tbody>
</table>
CINAHL Search Results

1. A needle-free powder lignocaine delivery system reduced the pain of venipuncture in children.
   Subjects: Administration, Topical In Infancy and Childhood; Pain Preschool: 2-5 years
   Cited References: (2)

2. A Randomized Double Blind Trial of Needle-free Inject Lumbar Puncture.
   Subjects: Lidocaine Administration and Dosage; Anesthesia, Local; Infant, Newborn: birth<1 month
   Cited References: (2)
Save And Manage Searches

1. Search History/Alerts
2. Save Searches / Alerts
3. Sign In
4. Folder List
5. Save

- Folder List: Name of Search/Alert: Lidocaine
- Search History/Alerts: Print Search History, Retrieve Searches, Retrieve Alerts
- Save Searches / Alerts
- Search Terms: Search with AND, Search with OR, Delete Searches
- Search Options: Expanders - Apply equivalent search
- Search modes - Boolean/Phrase
Export CINAHL Citations To Endnote

Option 1: Add to Folder
Add the results page by page till finish
Go to Folder & select all citations
Click Export

1. Select / deselect all
2. Page: 1
3. Export Manager
4. Save
   - Direct Export in RIS Format (e.g. CITAVI, EasyBib, EndNote, ProCite, Reference Manager, Zotero)
   - Direct Export to EndNote Web
   - Generic bibliographic management software
   - Citations in XML format
   - Citations in BibTeX format
   - Citations in MARC21 format
   - Direct Export to RefWorks
   - Direct Export to EasyBib
   - Download CSV

Number of items to be saved: 54
Remove these items from folder after saving
Save
Option 2: Email link to download exported results

You will receive an email link to download the RIS file. E.g., The export of your search results is complete. You may download the file here ...

Import the RIS file into EndNote Library.
8. REPORTING THE SEARCH

a. Reporting the Search Method
b. PRISMA Flow Diagram
Reporting Literature Search

In Methods section, report

- The names of the database searched (dates of coverage)
- The dates of the last search for each database
- PICO concepts that were searched for
- Limits applied (e.g., publication date, study design, language, etc.)
- Other sources searched (grey literature, handsearching, reference list)
- List individuals or organizations contacted
- Include the detailed search in an Appendix

Record the number of search results retrieved for each database and fill this total number in the PRISMA flow diagram (see next slide)
PRISMA Flow Diagram

- PRISMA (Preferred Reporting Items for Systematic Reviews and Meta-analyses)

- A transparent way of reporting your search results of systematic reviews and meta-analyses

Source: http://prisma-statement.org/prismastatement/flowdiagram.aspx
Searching is an iterative process

Revise your search till you are satisfied with the results
9. ENDNOTE

- Remove Duplicates (E-Learning)
- Export EN Library To EXCEL
- Cite While You Write (CWYW) (E-Learning)
Finding & Removing Duplicates
Exporting EndNote Citations To Excel
(Use the customised output style ‘NUSLib_SysRev.ens’)

1. Go to NUS Systematic Review Libguides
2. Copy the ‘NUSLib_SysRev.ens’ file
3. On your computer, locate where the Endnote programme folder called ‘Styles’
4. Saved the ‘NUSLib_SysRev.ens’ into the ‘Styles’ folder as shown:
Exporting EndNote Citations to Excel
(screening for relevant studies)

5. Back to EndNote Library, select the ‘NUSLib_SysRev.ens’ style
6. Go to File>Export>export the SysReview.txt file (according to your file name) on your desktop
7. Open this file in Excel and follow the steps shown in the next slide
Steps To Bring .txt File Into EXCEL

1. Open Excel and go to the Data tab.
2. Click on "From Text" and then "From Other Sources".
3. Locate and select your .txt file.
4. Choose "Delimited" and select the appropriate delimiters (Tab, Semicolon, Comma, Space, etc.).
5. Click on "Finish" to import your .txt file into Excel.
Example Of Exported References In Excel
Using ‘NUSLib_SysRev” output style

Manually insert a header line

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
<th>K</th>
<th>L</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NO</td>
<td>AUTHOR</td>
<td>YEAR</td>
<td>TITLE</td>
<td>JOURNAL</td>
<td>VOLUME</td>
<td>ISSUE</td>
<td>NAME OF DATABASE</td>
<td>ABSTRACT</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>R. Caltagir</td>
<td>2018</td>
<td>A Random Acad Emerg</td>
<td>25</td>
<td>3</td>
<td>PubMed</td>
<td>OBJECTIVES: Lumbar punctures (LPs) are commonly</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>P. Stoltz</td>
<td>2017</td>
<td>Comparis J Pediatr N</td>
<td>37</td>
<td>PubMed</td>
<td>PURPOSE: Needle procedures, like venipuncture and</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>J. Capetil</td>
<td>2019</td>
<td>Anesthesiol J Endod</td>
<td>45</td>
<td>3</td>
<td>PubMed</td>
<td>INTRODUCTION: Needle-free anesthetic delivery is a</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>N. G. Uspa</td>
<td>2018</td>
<td>Randomiz Pediatr Emerg</td>
<td>34</td>
<td>4</td>
<td>PubMed</td>
<td>OBJECTIVE: Transurethral bladder catheterization (T</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>M. Gozdeo</td>
<td>2016</td>
<td>A Needle-l Pak J Med</td>
<td>32</td>
<td>3</td>
<td>PubMed</td>
<td>OBJECTIVES: Local anesthetic infiltration is also a pr</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>B. E. Earp,</td>
<td>2017</td>
<td>Needle-Fr J Hand Surg</td>
<td>42</td>
<td>8</td>
<td>PubMed</td>
<td>PURPOSE: To evaluate the efficacy of needle-free jet</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>8</td>
<td>S. Vadebo</td>
<td>2017</td>
<td>Treatment Dermatol</td>
<td>43</td>
<td>2</td>
<td>PubMed</td>
<td>BACKGROUND: OnabotulinumtoxinA (OnabotA) inj</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>K. R. Patel</td>
<td>2019</td>
<td>The Anest Hand (NY)</td>
<td></td>
<td></td>
<td>PubMed</td>
<td>Background: The aim of this preliminary study was</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>11</td>
<td>E. Doughe</td>
<td>2019</td>
<td>The Effect Female Pe</td>
<td>25</td>
<td>2</td>
<td>PubMed</td>
<td>OBJECTIVE: The objective of this study was to deter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>12</td>
<td>P. R. Math</td>
<td>2018</td>
<td>Comparis Korean JA</td>
<td>71</td>
<td>2</td>
<td>PubMed</td>
<td>BACKGROUND: The preferred management strategy</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>13</td>
<td>G. Latsios,</td>
<td>2017</td>
<td>Anesthesiol J Interf Car</td>
<td>30</td>
<td>4</td>
<td>PubMed</td>
<td>OBJECTIVE: The aim of the present study was to ass</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>14</td>
<td>M. M. Lunt</td>
<td>2015</td>
<td>The use of Acad Emerg</td>
<td>22</td>
<td>4</td>
<td>PubMed</td>
<td>OBJECTIVES: The needle-free jet injection system was</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>15</td>
<td>N. N. Dab</td>
<td>2007</td>
<td>Needle-less Quintesse</td>
<td>38</td>
<td>10</td>
<td>PubMed</td>
<td>OBJECTIVES: To clinically evaluate the jet injection</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>16</td>
<td>W. T. Zem</td>
<td>2016</td>
<td>Safety anc Clin J Pain</td>
<td>32</td>
<td>3</td>
<td>PubMed</td>
<td>OBJECTIVES: The purpose of this study was to evalu</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>17</td>
<td>J. R. Haba</td>
<td>2017</td>
<td>The Ram F Dermatol</td>
<td>43</td>
<td>4</td>
<td>PubMed</td>
<td>BACKGROUND: Shave skin biopsies are essential pro</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>18</td>
<td>S. Kelly, J.</td>
<td>2017</td>
<td>Transfor J Vasc Access</td>
<td>18</td>
<td>3</td>
<td>PubMed</td>
<td>BACKGROUND: &quot;Needle pokes&quot; are the most frequen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Inserting Citations

Method 1 : Find Citation
a. In Word document, click **Insert Citation**
b. Search for a word in any field (e.g. title, author)
c. Select the references that you want to insert into your paper

Method 2 : Insert Selected Citation(s)
a. In EndNote library, select a reference
b. Go to Word document and place cursor at the insertion point
c. Click on **Insert Citation > Insert Selected Citation(s)**
Editing Citations/References

a. This is where you remove a citation if you no longer want to cite it. Or, edit a reference instead of changing it manually on the Word document.

b. Use this to exclude author or year in the in-text reference, or add page number.
To change the citation style
In Word document, select **EndNote X9 tab**: 
At the Style dropdown box, click on **Select Another Style**…
Choose a style from the dialogue box
Click ‘Choose’, the style of choice will be ready for your selection
Convert To Plain Text (PC)

EndNote tab > Convert Citations and Bibliography > Convert to Plain Text

A copy of the Word document will be created with no field coding. You should do this before sending document to a publisher or submit to supervisor as the field coding may interfere with other software, e.g. layout applications used by publishers.
Backup EndNote Library

1. Save the complete Library to a single compressed file (.enlx), including .DATA folder.

2. To backup: File > Compressed Library

3. To decompress: double click file

4. ‘Make Stuff Safe’
   - Save a copy to a secure storage
   - Update regularly
APPENDIX 1: VIDEOS HOW TO EXPORT SEARCH RESULTS FROM DATABASES INTO ENDNOTE

PubMed
https://youtu.be/Bndii3dQ1kw

Embase
https://youtu.be/VcJpb0YztkA

Scopus
https://youtu.be/alwH-ENkHIQ

Cochrane
https://youtu.be/QHXWaAZZBqE

CINAHL
https://youtu.be/KWc-G_FlkFQ

PsycINFO
https://youtu.be/4qEh0HsBQGs

Library Subject Guide
http://libguides.nus.edu.sg/c.php?g=145503&p=953994

Endnote’s CWYW functions
http://libguides.nus.edu.sg/Endnote
THANK YOU

Please give us feedback on your learning experience